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Palm Globe

Palm Globe is a program which displays the Earth as a globe on a PalmPilot , Palm
III , or IBM Workpad . You can choose to view the globe from any direction, or select
one of a number of “standard” views.

In addition to simply displaying a picture of the world, Palm Globe will also let you light
the globe as though by sunlight – so you can see at a glance those areas of the globe
where the sun has risen, and where it is night. Optionally, the direction of the sun can
be shown for any viewpoint, so you can use Palm Globe as a sun compass.

Further options add shading to the globe for a three-dimensional effect, rotate the globe
with the sun, and let you measure distances between two points on the globe. Other
features are described in detail below.

This document includes:

• an introduction to Palm Globe (this section)

• installation instructions

• a guide to using Palm Globe

• background and other details.

The algorithms, data, and code for Palm Globe were first developed for PMGlobe, a pro-
grammable globe application for OS/2. The current releases of both Palm Globe and
PMGlobe are available from:

http://www2.hursley.ibm.com
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Installation

System requirements

Palm Globe should run correctly on devices whose operating system is Palm OS  version
2.0 or later. This includes:

• The PalmPilot and PalmPilot Professional

• The Palm III

• The IBM Workpad and IBM Workpad 2

• A Palm OS Emulator, with version 2 or version 3 ROM image.

50 KiloBytes (50K) of free memory is recommended (Palm Globe uses about 36K).

You will also need a desktop or other suitable computer to install the software.

Installing Palm Globe

Before installing this (or any other) software onto your Palm OS computer, it is recom-
mended that you back up your current data by running HotSync.

The Palm Globe code is distributed as a compressed pglobe.zip  file which includes the
software license (license.txt ), the Palm Globe program (pglobe.prc ), and this docu-
ment (pglobe.pdf ). To install the program:

1. Download the pglobe.zip  file to your desktop machine (that is, the machine you
HotSync with).

2. Extract the files from the pglobe.zip  file using a tool such as WinZip or UnZip.

3. On your desktop machine, start the Palm or Workpad Install tool.

4. Click on the Browse  button and select the pglobe.prc  file which you just extracted.

5. Click on the Install  button and confirm if requested.

6. Place your Palm or Workpad device in its cradle and press the HotSync button. The
program will then be installed near the end of the HotSync process.

Note: If you unzipped the program using a command prompt window, then it may be
convenient to start the installer with a command. For example, for a typical Workpad
installation on Windows, the command might be:

c:\workpad\instapp pglobe.prc

which will start the installer with the pglobe.prc  file already selected.
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Using Palm Globe

Starting to use Palm Globe

When you first start Palm Globe, you will be shown the Time Zone dialog (see page 11).
Palm Globe needs to know your time zone so it can calculate the sun’s position. In the
dialog, enter your winter time zone offset in hours ahead of Greenwich Mean Time (GMT)
and also check that the daylight savings adjustment is set correctly.

For example, New York is –5 hours, and Paris is +1 hour, both with a one hour adjust-
ment in the summer.

Once you have set your time zone, tap the Done  button; Palm Globe will then proceed to
show you the globe with your time zone facing you, and lit as though by the sun. On the
dark (night) side of the globe, land masses are indicated by lightly dotted areas; in sun-
light they are solid bright areas.

Using the stylus with Palm Globe

You use the stylus with Palm Globe just as with other applications; in addition, Palm
Globe allows direct navigation using the stylus:

• Tap on the globe (that is, within the circle where the globe is drawn) to select a point
on the surface. The globe is then redrawn with the selected point at the center of
the circle.

• Tap off the globe, or in the title bar area, or on the Menu  button at the bottom left
of the screen, to bring up the menu bar for Palm Globe choices.

Menu bar choices

The Palm Globe menu choices can be selected from the menu bar in the usual way, or
they may all be selected by the Graffiti short cut shown next to the choice. They fall into
three groups:

View
is used to select a fixed viewpoint from which the globe is seen, change movement
settings, or to enter or select a custom viewpoint.

Effects
is used to choose the lighting effects (sunlight or not), shading, and twilight setting.

Options
lets you change the title bar (for example, to show distance calculations), time zone,
and other settings, and also offers tips (help) and the About choice.

These groups are described in the three following sections.
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The View menu

The View menu is used to select a standard viewpoint from which the globe is seen,
change movement settings, or to enter or select a custom viewpoint. It lists the following
choices:

Set viewpoint...
Opens the Viewpoint dialog (see page 5) which lets you select a particular point on
the globe’s surface.

Find viewpoint
Places the custom viewpoint at the center of view.

Movement settings...
Opens the Movement settings dialog (see page 6) which lets you change settings that
affect movement of the view of the globe.

Europe & Africa (0°)
Places the Intersection of the Equator and the Greenwich Meridian (0°N, 0°E) at the
center of view.

Americas (90°W)
Places 0°N, 90°W at the center of view.

India & Asia (90°E)
Places 0°N, 90°E at the center of view.

Pacific (180°)
Places the Pacific ocean (0°N, 180°E) at the center of view.

North Pole
Places 90°N, 0°E at the center of view.

South Pole
Places 90°S, 0°E at the center of view.

Snap to equator
Centers the view at latitude 0°N and leaves the longitude at the center of view
unchanged.

Snap to Greenwich
Centers the view at longitude 0°E and leaves the latitude at the center of view
unchanged.

All menu choices may be selected by the Graffiti short cut shown next to the choice.
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The Viewpoint dialog

The Viewpoint dialog lets you enter the coordinates (latitude and longitude) of a point on
the surface of the globe. If a valid point is entered, the Done  and Tap buttons will be
visible and you can then save the point (by tapping Done) or both save and select the
point by tapping Tap. The latter has the same effect as tapping the globe directly with
the stylus, with the advantages that:

• the entry can be more precise than when using the stylus

• you can “tap” on points that cannot be seen (for example, in darkness, or on the other
side of the globe).

A coordinate may be specified in degree°minutes'seconds"  format, or in degree.deci-

mal  format, as described in detail in Formats for specifying degrees (see page 15).

The Paste  button is used for directly pasting coordinates into the dialog. For instance,
if you had a list of cities and their coordinates in a Memo Pad document you could use
the Palm Find  button (at the bottom right of the screen) to find the line:

37°48N 122°24W San Francisco

The two coordinates (or the whole line) can then be selected by dragging the stylus across
the line, and then copied to the clipboard using the Copy function from the Edit menu
(command /C).

On returning to Palm Globe and the Viewpoint dialog, the coordinates can simply be
entered by tapping the Paste  button. This special paste button takes the first two can-
didate words (words that start with a sign or a digit) and puts the first into the latitude
field and the second (if any) into the longitude field.

At any time, the Undo  button may be used to revert the fields to the values they had when
the dialog was entered.

Like all the Palm Globe dialogs, tapping on the “i” icon on the title bar of the dialog gives
tips on using the dialog.
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The Movement settings dialog

The Movement settings dialog lets you change settings that affect movement of the view
of the globe. Any changes take effect when the Done  button is tapped. The settings are:

Move globe to tapped point
When this setting is checked, tapping on the globe (whether by using the stylus
directly, or using the Tap button of the Viewpoint dialog) will cause the view to be
changed so the tapped point becomes the center of the view. It is useful to uncheck
this setting when measuring distances (see page 10).

Rotate with sun
When this setting is checked, the view of the globe will rotate in synchronization
with the sun. That is, when the globe is refreshed automatically the longitude of the
current viewpoint is adjusted by the amount that the longitude of the sun has
moved. The latitude of the current viewpoint is not changed.

At any time, the Undo  button may be used to revert the settings to the values they had
when the dialog was entered.
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The Effects menu

The View menu is used to choose the lighting effects (sunlight or not), shading, and the
twilight setting. It lists the following choices:

Set lighting...
Opens the Lighting dialog (this page) which lets you choose how the globe is lit.

Set twilight...
Opens the Twilight dialog (see page 8) which lets you choose how the twilight band
is shown. This dialog can also be opened directly from the Lighting dialog.

The Lighting dialog

The Lighting dialog lets you choose how the drawing of the globe is lit. It has three
checkboxes, which take effect when the Done  button is tapped:

Sunlight
Chooses “sun lighting” of the globe. This lets you see at a glance which parts of the
world are in daylight, and which are in the dark. This lighting is (of course) time
dependent, so Palm Globe needs to know the correct time of day and your time zone
in order to show the sunlight correctly.

If Sunlight is selected, the globe will normally be redrawn at regular intervals, as
selected from the Other settings dialog (see page 12), showing how the sunlight
moves across the earth. The section on accuracy (see page 13) gives more details.

Starlight
When Sunlight is selected, the dark side of the earth appears completely black. To
make this more interesting, the Starlight choice makes the land masses on the dark
side visible as a dark grey mottled pattern (if you cannot see them, try adjusting the
contrast of your display).

Starlight is only meaningful if Sunlight is selected, so the checkboxes are coupled
(selecting Starlight will also select Sunlight, etc.).

3-D
This choice adds shading, to give the globe a “three-dimensional” (3-D) appearance.
On the low-resolution Palm screen, this inevitably gives a rather grainy and mottled
appearance – in particular, the details of land and water boundaries may be
obscured. However, the shading does convey the roundness of the earth better than
the flat lighting, and the position of the sun becomes more obvious.

If 3-D is selected without selecting Sunlight, artificial lighting from the front and top
left of the globe is supplied.

If none of the three choices are checked, then “flat” lighting, as though for a map, is used;
all land masses are equally visible.

The Twilight  button is available as a convenience; it opens the Twilight dialog (see page
8), which lets you choose how the twilight band is shown on the globe, without having to
leave the Lighting dialog first.
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At any time, the Undo  button may be used to revert the checkboxes to the values they
had when the dialog was entered.

The Twilight dialog

The Twilight dialog lets you choose how the twilight band is shown on the globe, when
Sunlight is in effect.

The sun is not a point source of light, and the atmosphere scatters its light, too. There-
fore, sunlight is seen on the dark side of the earth for some time before the sun rises and
for some time after it sets. You can select to see all, part, or none of this twilight band
on the globe.

The twilight band, when shown, is normally shown bright, or is shaded if 3-D is
selected.1 Beyond the selected band, the earth is shown as dark.

You may choose any one of the twilight settings; the one chosen takes effect when the
Done  button is tapped:

Theoretical sunrise/set
This setting lights the earth as though by a point source at the center of the sun; the
sunrise/set line is shown as though light ceased when the center of the sun crossed
the horizon, and so no twilight can be seen; exactly half the globe is lit.

Ideal sunrise/set
This is a practical and generally accepted definition of sunrise and sunset (fifty
minutes of angle after the theoretical sunrise/set) which allows for the diameter of
the sun and common atmospheric effects. The line seen on the globe joins the points
at which the disc of the sun will have just disappeared or be just about to appear,
and encloses a very narrow band of twilight.

Civil twilight
This setting marks the end of “civil twilight” – a convenient point used for legal
purposes (for example, when it is too dark to carry out certain tasks). Please note
that Palm Globe’s rendering of this line must not be used for any critical or legal
decisions; errors and bugs are always possible, and the definition used by Palm Globe
(six degrees after the theoretical sunrise/set) may not match the legal definition used
in your country.

Naval twilight
This setting indicates the points where it is dark for all practical purposes: the cen-
ter of the sun is twelve degrees below the horizon.

Astronomical twilight
With this setting, there is no sharp boundary; with shading, light fades to zero,
where it is perfectly dark. At this point on the surface no effects from sunlight can
be detected, and the center of the sun is eighteen degrees below the horizon.

At any time, the Undo  button may be used to revert the checkboxes to the values they
had when the dialog was entered.

1 Shading may appear mottled or granular on low-resolution devices.
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The Options menu

The Options menu lets you change the title bar (for example, to show distance calcu-
lations), time zone, and other settings, and also offers tips (help) and other information.
It lists the following choices:

Set title bar...
Opens the Title Bar dialog (see page 10) which lets you choose whether the title bar
is shown and what information is shown on it.

Set time zone...
Opens the Time Zone dialog (see page 11), used for setting the Time Zone and day-
light savings adjustment for the device.

Other settings...
Opens the Other settings dialog (see page 12) which lets you change some miscella-
neous settings.

ReDraw
Forces the globe to be redrawn immediately.

Help
Displays tips on using Palm Globe.

About
Displays the version of Palm Globe and other information about the program.
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The Title Bar dialog

The Title Bar dialog lets you choose whether the title bar is shown and what information
is shown on it.

You may choose any one of the title bar settings; the one chosen takes effect when the
Done  button is tapped:

Distance from previous tap
When this setting is chosen, the title bar displays the distance between two points
tapped on the globe (whether by using the stylus directly, or using the Tap button
of the Viewpoint dialog). After the first tap, each new tap shows the distance from
the previous tapped point.

When using this setting, it is helpful to uncheck Move globe to tapped point in the
Movement settings dialog so the globe is not moved after each tap. You can use the
standard view choices in the View menu to position the globe, instead.

The distance shown is the great circle distance; that is, the shortest distance on the
surface of the globe between the two points. This is the distance used for calculating
air miles, etc. The section on accuracy (see page 13) gives some more details.

Coordinates of center point
Displays the latitude and longitude of the point at the center of the view of the globe.

Coordinates of sun position
Displays the latitude and longitude of the point at which the sun is directly over-
head. These coordinates are updated whenever the globe is redrawn, to match the
current view.

Coordinates last tapped
Displays the latitude and longitude of the point last tapped on the globe (including
points tapped using the Tap button of the Viewpoint dialog).

Local date and time
Displays the current local date and time, updated every minute. The format used
can be changed by using the Palm device’s Preferences application.

Empty title bar
Leaves the display area of the title bar empty (white).

No title bar (full screen)
Choosing this removes the title bar; the globe is then redrawn, filling the screen.
The Palm Globe menus are still accessible by tapping off the globe or on the Menu
button, as usual.

At any time, the Undo  button may be used to revert the checkboxes to the values they
had when the dialog was entered.
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The Time Zone dialog

The Time Zone dialog lets you set the Time Zone and daylight savings adjustment for the
program. Palm Globe needs to know this information so it can calculate the sun’s posi-
tion, given the (local) date and time known to the Palm device. The time zone setting,
therefore, should match the setting of the device’s clock.2

The dialog has two adjustable settings, which take effect when the Done  button is tapped:

Offset
In this field enter the time zone offset in hours. This should be the offset from
Greenwich Mean Time (GMT) as measured during the winter, and is positive for
time zones east of Greenwich and negative for time zones west of Greenwich. If
necessary you can also specify minutes and even seconds by separating these fields
from each other using colons (with no blanks). Here are some valid offsets:

0 1 +5 –7 –7:00 9:30 –6:59:59

The format, therefore, is one or more digits of hours (with optional preceding sign),
followed by optional minutes and seconds fields (which may have leading zeros).
No other characters are accepted; the Done  button is only shown if the offset is valid.

As examples, here is a selection of offsets with some places within each zone:

-9  Anchorage

-8 Vancouver, San Francisco

-7  Calgary, Denver

-6 Chicago, Dallas, Mexico City

-5 Ottawa, Washington D.C., Lima

-4  Caracas, Santiago

-3 Greenland, Rio de Janeiro

0 London, Greenwich, Casablanca

+1 Madrid, Paris, Frankfurt

+3 Moscow, Nairobi

+5:30  New Delhi

+8 Lhasa, Beijing, Singapore, Perth

+9 Tokyo

+10 Micronesia, Canberra, Sydney

+12 Kamchatka peninsula, Wellington

Daylight
These pushbuttons let you choose the appropriate daylight savings adjustment, in
hours. This is typically either zero (in the winter) or one (in the summer).

2 This is not necessarily the time zone which you are in. If you leave the clock set to a different time zone,
perhaps your home time zone, leave Palm Globe’s setting at that time zone, too.
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Palm Globe does not currently make this adjustment automatically, as the date and
time of the change (if any) varies from country to country.

At any time, the Undo  button may be used to revert the settings to the values they had
when the dialog was entered.

The Other settings dialog

The Other settings dialog lets you change some miscellaneous settings. Any changes take
effect when the Done  button is tapped. The settings are:

Show sun direction (compass)
When this setting is checked, the direction of the sun from the center of the view (the
current viewpoint) is shown as a line superimposed on the globe. This is shown even
if the sun is not visible from the viewpoint.

If you set the viewpoint to be your actual position on the earth and then hold the
Palm device horizontal and align it so the line points at the sun (assuming it’s visi-
ble), then the top of the device will point to North.3

As well as acting as a sun compass, the aligned map of the globe will then show you
which direction to travel to get to any point visible in the shortest distance.

Note that the sun direction line is not shown if the sun is directly overhead (or is
directly under your feet).

Refresh automatically
When this setting is checked, the globe will be redrawn at the selected refresh
interval. The interval is selected by tapping on one of the pushbuttons, which
chooses a time in minutes. The time selected is the delay from when the globe fin-
ishes drawing to when the next draw is started. Choosing a short delay time may
use more power than a longer time, depending on the device.

Click when tapped
When this setting is checked, a click will be heard whenever the globe is successfully
tapped (whether by using the stylus directly, or using the Tap button of the View-
point dialog), provided that System sounds are switched on for the device as a whole.

At any time, the Undo  button may be used to revert the settings to the values they had
when the dialog was entered.

3 Unless the viewpoint is the North or South pole, in which case the top of the device points to the 180° or
the 0° (Greenwich) Meridian, respectively.
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Date and time limits and accuracy

The data used for presenting the globe are loaded in compressed form (from almost
exactly two Kilobytes). The coastline and lake data were compiled from several different
sources, with some manual editing to improve the representation in critical areas such
as narrow straits and isthmuses. The accuracy of the coastline and other data is not
guaranteed in any way, but is believed to be within 40km (25miles) in the worst case
(near the equator) and significantly better in the East-West direction in Northern and
Southern latitudes.

When distance calculations are carried out, the pen position can only be determined to
the nearest pixel (picture element) on the screen. The longitude and latitude is then
reported as being at the center of that pixel. However, more accurate positions can be
entered by using the Tap button in the Viewpoint dialog, which simulates a pen tap at the
exact point specified.

Distances are then calculated between the two coordinates selected and should be accu-
rate to the nearest unit (km or mile), or 0.2%, whichever is greater. The 0.2% limit is a
consequence of the assumption used in the calculation that the earth is spherical (which
it is not).

Time and sun position calculations are only important when the Sunlight option is
selected. In this case, Palm Globe needs to know the current date and time-of-day (taken
from your computer’s clock – make sure it is set correctly). It also needs to know which
time zone that clock is set to: you will have been asked for this when Palm Globe was first
started (you may also need to change it if your computer clock changes for daylight sav-
ing, summer, or winter time).

From the current time and time zone information, Palm Globe can determine the
apparent solar time (which is as much as 16 minutes different from the Civil time used
for clocks) and hence the sun’s position. This is then used to display the globe as though
lit by the sun: the light/dark dividing line thus shows where the sun is rising or setting.

The various calculations done should give an accuracy of sun position that leads to a
sunset or sunrise indication that is correct to within twenty seconds of time. Actual
sunset or sunrise times will be a little different because of atmospheric effects, which
vary with the time of year, the weather, and latitude. However, Palm Globe does give a
useful indication of sunrise and sunset, and of course lets you see at a glance which parts
of the globe are in night or daylight.

Celestial events such as equinoxes, and solstices especially, are very dependent on the
earth’s movements; equinoxes should be correct within some tens of minutes, solstices
should be correct within about ten hours.

Please note that results will be incorrect if you set your computer’s date to be earlier than
1 January 1990. Also, the formulae used to calculate the sun’s position may prove to be
inaccurate at some distant time in the future, because the earth’s movement is not
entirely predictable.
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Performance considerations

Palm Globe is designed as a “32-bit” application, with heavy use of long (32-bit) integers.
All computation is done using long integers, so no floating-point overhead is incurred.

The relatively long draw times are due to the number of calculations needed; for each
pixel that is part of the globe, the program must determine the corresponding latitude
and longitude, whether that point is land or water, and how brightly it is lit (which
depends on the angle of the surface of the globe at that point, relative to the sun’s current
position). Finally, an enhanced error diffusion algorithm is used to simulate a range of
tones on the image.

In general, therefore, the simpler the image presented the faster it is drawn. Selecting
Sunlight, Starlight, or 3-D all slow down the drawing. Similarly, non-equatorial (tilted)
views take significantly longer to draw than equatorial views (hence the Snap to equator
choice).

As a rough guide, the simplest (flat lighting, equatorial view, no sunlight) image at the
smaller size should take about 7 seconds to draw on a PalmPilot (16MHz processor). The
time taken is inversely proportional to the speed of the processor and proportional to the
square of the image diameter. The most complicated drawing (3-D shading, non-equa-
torial view, sunlight, and full screen) might take two or three times longer.

When you switch to Palm Globe from another application, the last-shown image is dis-
played first; this takes much less time.

Acknowledgement: I would especially like to thank John Marshall for his assistance in
reducing the cost of divisions during pixel computations, which resulted in a 30% per-
formance improvement.
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Formats for specifying degrees

A coordinate in degrees, as used in the Viewpoint dialog (see page 5), may be specified
in degree°minutes'seconds"  format, or in degree.decimal  format.

If the degree value is specifying a latitude or longitude, then it may be followed by one
of the characters N, S, E, W (in either case), as appropriate. The default is N (North) for
latitude and E (East) for longitude. A leading minus sign is allowed in either format, and
negates the direction implied by any N, E, S, or W. A leading plus sign is also allowed;
it has no effect.

No blanks are allowed; the seconds, or seconds and minutes, may be omitted, as may
insignificant leading zeros (and trailing degrees, minutes, or seconds indicators). The
syntax is therefore one of:

[+|–][d]d[o[m]m['[s]s["]]][x]
[+|–][d]d[.[[d]d]d][x]

where the degree indicator in the first format may be either the letter O (either case) or
the true degree character (°, decimal 178 in Unicode and on Palm OS devices).4

Examples (all specifying a negative angle of 12 degrees 30 minutes):

12°30'S –12°30 12°30W –12.5
12°30'0"S –12°30'00N –12.500E 12o30s

4 The Graffiti strokes for the degree character are Extended Shift (backslash drawn from top left) followed
by an O drawn clockwise from the lowest point.

Palm Globe 1.10 Copyright (c) IBM Corporation 1998. All rights reserved. 15



Index

3

3-D choice 7

A

About option 9
accuracy 13
Americas view 4

B

band, twilight 8

C

calculation, distance 10
changing viewpoint 3
click when globe tapped 12
compass settings 12
coordinates

display of 10
entering 5
from Memo Pad 5

D

date and time display 10
date limits 13
Date line view 4
daylight 7
daylight savings adjustment 11
degree character 15
degrees, specifying 15
dialog

Lighting 7
Movement settings 6
Other settings 12
Time Zone 3, 11
Title Bar 10
Twilight 8
Viewpoint 5

distance
calculation 10
display of 10

Done button 5, 6, 7, 8, 10, 11, 12

E

Effects menu 7
equator view 4
Europe & Africa view 4

Palm Globe 1.10 Copyright (c) IBM Corporation 1998. All rights reserved. 16



F

Find button, using 5
find Viewpoint 4
forcing redraw of the globe 9
formats

degrees 15
hours 11

freezing the globe position 6

G

GMT 11
great circle distance 10
Greenwich Mean Time 11
Greenwich Meridian view 4

H

Help option 9

I

India & Asia view 4
installation 2

L

latitude
display of 10
setting 4

lighting
artificial 7
sunlight 7

Lighting dialog 7
limits 13
longitude

display of 10

setting 4

M

measuring distance 10
Memo Pad, source of coordinates 5
Menu

choices 3
displaying 3
Effects 7
Options 9
View 4

Menu bar 3
Movement settings dialog 6
moving the globe position 6

N

North, finding 12
North Pole view 4

O

Options menu 9
Other settings dialog 12

P

Pacific view 4
Palm Globe 1

Effects menu 7
installation 2
Options menu 9
starting 3
using 3
using as compass 12
View menu 4

Paste button 5
performance 14
position display 10

Palm Globe 1.10 Copyright (c) IBM Corporation 1998. All rights reserved. 17



R

ReDraw option 9
redrawing the globe 12
refreshing the globe 12
requirements, system 2
rotating globe with sun 6

S

selecting a point 5
selecting points 3
sound

See click
South Pole view 4
speed of drawing 14
standard views 4
Starlight choice 7
starting Palm Globe 3
stylus, use of 3
summer time adjustment 11
sun

compass 12
coordinates display 10
direction display 12
lighting selection 7
rotating with 6

Sunlight choice 7
system requirements 2

T

Tap button 5
three-dimensional shading 7
time

display of 10
limits 13
refresh delay 12

time zone 3

adjustment 11
dialog 11
offset 11

tips on using Palm Globe 9
Title bar

coordinates display 10
date and time display 10
dialog 10
distance display 10
empty 10
removing 10

Twilight button 7
Twilight dialog 8

U

Undo button 5, 6, 8, 10, 12
user’s guide 3
using Palm Globe 3

V

version, of Palm Globe 9
view

Americas 4
at equator 4
at Greenwich Meridian 4
Europe & Africa 4
India & Asia 4
North Pole 4
Pacific (Date line) 4
South Pole 4
Viewpoint 4

View menu 4
Viewpoint dialog 5

W

winter time adjustment 11

Palm Globe 1.10 Copyright (c) IBM Corporation 1998. All rights reserved. 18


